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1. GETTING STARTED 

1.1. Pre-requisites 

It is assumed the instrument is correctly set up according to the relevant User Manual. 

The controller operates on Windows 10 IoT Enterprise LTSC. To ensure stability, it does not 

install Windows updates automatically. Keit recommends running Windows updates before 

setting up the IRmadillo. 

KeitSpec should only be run in the Spectrometer User account. The IRmadillo can connect to 

only one instance of KeitSpec. If KeitSpec is opened in another user account, it will not connect 

to the spectrometer. 

1.2. The Spectrometer tab: an overview 

When the controller powers on, KeitSpec automatically loads with the Spectrometer tab open. 

It will connect to the IRmadillo and open the last used project file. The IRmadillo comes with a 

factory background scan that loads automatically. 

Before you start taking spectral measurements, it is important to ensure that the spectrometer 

is connected, is stable and is purged. Look for the following indicators: 

 

Figure 1: The Spectrometer tab 

 

1. Spectrometer Status indicators 

The following indicators may be shown: 

Green tick: IRmadillo is connected and is thermally stable. 

 Red thermometer icon: IRmadillo is connected but is not yet thermally stable. 

Wait for the IRmadillo to stabilise before taking any measurements. 
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 Red cross: IRmadillo an error. Refer to the troubleshooting section of the 

IRmadillo User Manual. 

 Black arrows: IRmadillo is not connected 

 

  Not saving icon: IRmadillo is not autosaving data  

 

Before collecting data, ensure that the green tick is showing, and that the status is 

‘Spectrometer OK’. 

 

2. Errors and Warnings pane 

Displays any errors or warnings on the IRmadillo. It should read "No Errors or Warnings." 

If not, refer to the troubleshooting section of the IRmadillo User Manual. 

 

3. Spectrum view 

Displays the live spectrum from the IRmadillo, updating every ten seconds. 

 

4. Water vapour absorbance region 

Water vapor peaks appear between 1350 cm⁻¹ and 1700 cm⁻¹. Broad peaks in this region 

suggest a poor air purge; check the IRmadillo User Manual. Narrow peaks elsewhere 

indicate the probe's sensing ATR element needs cleaning and drying. Refer to DOC0935 

for guidance. 
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1.3. Collecting spectra in a continuous process 

These steps guide you in creating a new continuous collection project, collecting a background 

spectrum, and selecting settings. For measuring individual spectra of discrete samples, see 

Section 1.9 Manual sampling. 

1. Create a new continuous project by clicking the purple folder icon in the top left, then 

choose Create New Empty Project > Continuous Collection… 

 

 

Figure 2: Creating a new Empty Continuous Collection project 

 

2. In In the window that opens, navigate to the desired location, enter a project name, 

and click OK. 

 

 

Figure 3: Creating a new Continuous Collection project 
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3. Record a background spectrum. Keit recommends a 30-minute air scan. Ensure the 

probe ATR element is clean. Adjust the scan duration using the Time to Collect 

Background inputs. 

 

 

Figure 4: Changing background spectrum collection settings 

 

Next, click Background Scan > Collect New Background. 

 

 

Figure 5: Recording a new background spectrum 
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The Background Scan button turns green, and a progress bar at the bottom right shows 

the scan's progress. Once completed, the button returns to white. Note: background 

scan collection cannot be cancelled once started.  

 

Figure 6: Recording of a new background spectrum in progress 

 

4. You're now ready to collect spectra. On the Configure Acquisition tab, set the Scan 

Averaging Duration (default is 120 seconds). 

For details on the Data Communications Methods panel, see Section 1.8. 

The instrument will start recording spectra automatically once a valid background is 

detected. 

 

Figure 7: The Configure Acquisition tab 
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5. View spectra in real time on the Spectrometer tab. Interactive graphs display changes 

in absorbance and spectral power over time. A table in the bottom right corner provides 

the spectrometer's status.  

 

Figure 8: Viewing of incoming spectra  
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1.4. Loading a univariate model 

Loading a univariate model allows you to see how a spectral region evolves over time. It is 

simpler and less informative than the chemometric models described in Section 1.5 but can 

be useful for some applications. 

1. On the Configure Acquisition tab, click the Configure button. 

 

Figure 9: Loading a chemometric model 

 

2. A Chemometrics Editor window will open. Click the + icon on the left of the screen to 

open a menu of model types and select Add New Model>> Univariate. This will open 

an Edit Univariate window. 

 

Figure 10: The Chemometrics Editor 
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3. In the Edit Univariate window, use the Min and Max inputs to set the wavenumber 

range. Checkboxes allow you to toggle whether the Maximum, the Average and the 

Minimum are reported. When you have made your selection, click OK to load the 

model. 

 

 

Figure 11: Editing a Univariate model 

 

4. A model of type Univariate should now be loaded into the Chemometrics Editor 

window. When this model is selected, its details will be shown in the bottom panel.  

Additional models can be added using the + button as before. Models can also be 

deleted by right-clicking on a model and selecting Delete this Model. When you have 

added all your models, click Done to close this window. 

Click Done to finish. 

 

 

Figure 12: Applying a Univariate model 
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1.5. Loading a chemometric model 

Chemometric models allow you to view an interpretation of the spectra in terms of 

concentrations of chemical species, or diagnostic statistics of the collected spectra, in real 

time. 

1. On the Configure Acquisition tab, click the Configure button. 

 

Figure 13: Loading a chemometric model 

 

2. A Chemometrics Editor window will open. Click the + icon on the left of the screen to 

open a menu of model types and select the type of chemometric model to add. In this 

example we will use a PLS Toolbox (Solo_Predictor) model (see Section 3.1 

Configure Chemometrics for more information about available model types). Click the 

model type and, when the file explorer window opens, navigate to the model you want 

to load and click OK. 

 

Figure 14: The Chemometrics Editor window 
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3. A model can report several features of the spectra. In this example, the features are 

the DP3+ measurement, the Hotelling’s T2, and the Q residuals. Select the features to 

report by checking or unchecking the boxes. Check that the desired outputs are listed 

in the description window, then click OK when done. This will close the window. 

 

 

Figure 15: Adding a Solo_Predictor model 

 

4. Additional models can be added using the + button as before. Models can also be 

deleted by right-clicking on a model and selecting Delete this Model. When you have 

added all your models, click Done to close this window. 

 

 

Figure 16: Adding an additional chemometric model 
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5. The outputs of the model are now displayed in the Chemometrics panel. These values 

update in real time as spectra are collected. 

 

Figure 17: The Chemometrics panel 
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1.6. Filtering 

To reduce noise, consider applying an exponential filter to the IRmadillo’s predictions, 

depending on your process dynamics and chemistry changes.  

1. Open the Chemometrics Editor. This window shows all models currently loaded on 

your system and includes the Display Filtering column.  

 

Figure 18 Display Filtering Column 

2. Double-click the model in the Display Filtering column to edit the Display Filtering 

Times. This opens the Edit Display Filtering Times window:  

 

Figure 19 Edit Display Filtering Times 
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3. In the Edit Display Filtering Times window, enter the filter time constant in seconds. 

The example shows 10, 15, and 20 minutes. Press OK when done. 

 

4. The filtering time constant will appear in the Display Filtering column. Click Done to 

apply the filters.  
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1.7. Exporting data 

Data recorded by the spectrometer and processed by the models can be exported as a text 

file. 

1. Open the Project Data Viewer tab. The model outputs are shown in an interactive 

graph (top panel), which you can explore using the buttons in the top left corner. The 

spectra are displayed in the bottom panel.  

 

Figure 20: The Project Data Viewer tab 

 

2. You may wish to mark time points in an experiment. To do this, right click the interactive 

graph in the top panel at the point you wish to mark. A menu will open allowing you to 
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Set Marker Here. Clicking this will open a new window prompting you to name the 

time point. 

 

Figure 21: Adding a Marker 

 

3. To export the data, click the Export button on the right of the screen. 

 

 

Figure 22: Exporting data 

 

4. Selecting Export Metrics to TXT File will open a second menu allowing you to export 

either the model outputs currently displayed in the graph (As Viewed) or the entire 

dataset (All Data). Click your preference and a window will open, allowing you to 

navigate to the desired location to save your file. 
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Figure 23: Exporting chemometric predictions 

 

5. Similarly, selecting Export Spectra to File will open a menu to export only Spectra in 

View Range, All Spectra, or only Marked Spectra. 

1.8. Connecting to control system (DCS or PLC) 

KeitSpec provides four methods for data to be exported in real time: 

• Modbus RTU Slave (models ASM0627-xx-x-x-O-x-x only) 

• Modbus TCP Server 

• OPC-UA Server 

• Autosave to Folder 

These can be activated configured on the Configure Acquisition tab in the Data 

Communication Methods panel. Toggling the switches from OFF to ON adds new tabs to 

the main window. 

1.8.1. Modbus RTU Slave 

1. To enable Modbus RTU Slave, toggle the Modbus RTU Slave switch. This will create 

a new tab at the top of the window. 
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Figure 24: Enabling Modbus RTU Slave 

 

2. Open the Modbus RTU Slave tab. A list of Input and Holding Registers is given on the 

panel on the right-hand side, showing the various outputs and their addresses. To 

enable the connection, toggle the Enable Slave switch to the ON position. The text 

below will show Connected when the connection has been made. 

 

 

Figure 25: The Modbus RTU Slave tab 

 

3. For further details on connecting via Modbus RTU, refer to DOC0871 Commissioning 

Guide - data communication - Modbus RTU. 
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1.8.2. Modbus TCP Server 

1. To enable Modbus TCP Server, toggle the Modbus TCP Server switch. This will 

create a new tab at the top of the window. 

 

 

Figure 26: Enabling Modbus TCP Server 
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2. Open the Modbus TCP Server tab. A list of Input and Holding Registers is given on 

the panel on the right-hand side, showing the various outputs and their addresses. To 

enable the connection, toggle the Enable Server switch to the ON position. The text 

below will show Connected when the connection has been made. 

 

Figure 27: The Modbus TCP Server tab 

 

3. For further details on connecting via Modbus TCP, refer to DOC0817 IRmadillo 

Commissioning Guide – data communication – Modbus TCP/IP. 

1.8.3. OPC-UA Server 

1. To enable OPC-UA Server, toggle the OPC-UA Server switch. This will create a new 

tab at the top of the window. 

 

Figure 28: Enabling OPC-UA Server 
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2. Open the OPC-UA Server tab. To enable the connection, toggle the Enable OPC-UA 

Server switch to the ON position. The text below will show Connected when the 

connection has been made. 

 

Figure 29: The OPC-UA Server tab 

 

3. For further details on connecting via OPC-UA Server, refer to DOC0828 IRmadillo 

Commissioning Guide – data communication – OPC-UA. 

1.8.4. Autosave to Folder 

1. To enable autosaving to folder, toggle the Autosave to Folder switch. This will create 

a new tab at the top of the window. 
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Figure 30: Enabling Autosave to Folder 

 

2. Open the Autosave to Folder tab. The panel bounded by a blue rectangle allows you 

to navigate to a folder to save data into. The Enable Saving toggle enables automatic 

saving to the folder selected. 

 

 

Figure 31: The Autosave to Folder tab 

 

3. For further details on connecting via a watched folder, refer to DOC0876 IRmadillo 

Commissioning Guide – data communication – Watched Folder. 
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1.9. Manual sampling 

These steps lead you through the process of creating a new manual sample acquisition project 

and how to collect spectra manually. 

1. Create a new manual project by clicking the purple folder icon in the top left corner, 

then choose New Project > Manual Sample Acquisition… 

 

 

Figure 32: Creating a new Manual Sample Acquisition project 

2. In the window that opens, navigate to the desired location and enter a name for your 

project. Click OK to create the project.  

 

3. You should next record a background spectrum. Keit recommends a 30-minute 

background scan of air. Ensure that the probe ATR element is clean before doing so. 

The background scan duration can be adjusted using the Time to Collect 

Background inputs shown below. 
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Figure 33: Changing background spectrum collection settings 

 

Next, click Background Scan > Collect New Background. 

 

 

Figure 34: Recording a new background spectrum 

 

The Background Scan button will turn green and a progress bar at the bottom right 

of the window will show the progress of the background scan. When the background 

scan has completed, the Background Scan button will return to its original white 

colour. Please note that background scan collection cannot be cancelled once it has 

been started. 
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Figure 35: Recording of a new background spectrum in progress 

 

4. You are now ready to collect spectra. On the Sample Acquisition tab, enter the name 

of the sample you are measuring and set the time to scan and number of samples. 

Keit recommends scanning for 120 seconds and taking three samples.  

 

 

Figure 36: Collecting Manual Samples 

5. Place your sample on the probe tip. Click the blue Collect Sample button or press F1 

to collect samples. The Collect Sample button will go green during sample collection. 
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6. Spectra can be viewed once they have been saved in the Sample Acquisition tab. Click 

on a sample in the table to display its spectrum on the plot. You may select and display 

multiple spectra by ctrl+clicking or shift+clicking. 

 

 

Figure 37: Viewing Manual Samples 

 

7. To export the spectra of manual samples to a text file for import into a chemometrics 

modelling program, click the Export button, then select Export Spectra to File > All 

Spectra. 

 

Figure 38: Exporting spectra  
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2. THE SPECTROMETER TAB 

The Spectrometer tab provides setup information and ensures the instrument is working.

 

Figure 39: The Spectrometer tab 

1. The File menu 

a. Create New Project from existing Project: Creates a new project file of the same 

type (Continuous/Manual), copying all models, settings, and the background from 

the current open project file. 

b. Create new Empty Project: Creates a new empty project file (either Manual 

Sample Acquisition or Continuous Collection).  

c. Save Copy of current Project (including data): Creates a copy of the current 

project, including all spectral data. This is the safest way to duplicate a project; 

copying in your file browser while the project is open in KeitSpec may corrupt the 

project file.   

d. Open Project: Opens a project from disk. The project's background spectrum will 

replace the current background (if any). Use the Background Scan button options 

to load or collect a different background spectrum. 

e. Close Project: This option can be used to safely close a project. 

 

2. Context help 

Context help appears in a floating window, providing information about the control or 

display the mouse pointer is hovering over. Use this feature to learn more about the 

software interface controls. 
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3. More options 

a. Spectrometer Action 

i. Reset Spectrometer: If the spectrometer stops responding, reset it using 

this dropdown. 

ii. Reenable Sagnac TEC: For some older models of IRmadillo (ASM0627-xx-

x-A-x-x-x), exceeding the operating temperature range can damage 

electronics. Thermal stabilization will shut down automatically, and an error 

will appear in the Data Integrity pane (item 3110). Restart thermal 

stabilization when the IRmadillo returns to its specified temperature range.  

b. Change Timezone: Allows the user to change the timezone in which the project file 

is saved. 

c. Create data package for Health Check: Keit offers an annual health check as part 

of the IRmadillo’s Maintenance and Support Programme (MSP). This control 

gathers the necessary files for Keit to perform the health check. To enrol in the MSP, 

contact your sales representative.  

 

4. Background scan 

FTIR requires a background spectrum (reference scan) before measuring absorption. 

Collect the background spectrum before inserting the probe into the reaction or process.  

a. Collect New Background: Collects a new background spectrum for the duration 

that is given in the Time to Collect Background boxes. 

b. Load Background from other Project file: Loads the background spectrum from 

another project file. 

c. Save Background to KeitData file: Saves the background spectrum in Keit’s data 

format. 

d. Export Background to Text file: Saves the background spectrum as a human-

readable text file. 

e. Export Background to SPC file: Saves the background spectrum as an SPC file. 

f. Load Background from KeitData file: Loads a background spectrum that has 

been saved in Keit’s data format. 

g. Load Background from Autosaved History Folder: Background spectra are 

automatically stored on the IRmadillo’s controller. This control allows these 

backgrounds to be reloaded into KeitSpec. 

 

5. Cleaning Mode 

Manual Cleaning Mode returns spectra every 2 seconds, useful for cleaning the probe tip. 

In this mode, spectra are not analyzed, stored, or reported via DCS. To return to Normal 

Running Mode, click 'Dismiss' or close the window.  

6. Standby Mode 

Standby mode disables the emitter (infrared light source) in the probe. 

7. Spectrometer Status 

Shows the status of the spectrometer. For more information, see Section 1.2 The 

Spectrometer tab: an overview. 
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8. Simulated Mode 

Uses simulated data, allowing you to learn the software without a spectrometer. 

9. Spectrum 

Displays the current raw spectrum, absorption spectrum, and background reference 

spectrum. Use the top-left controls to zoom in on a specific spectral region.  

10. Data Integrity pane 

The spectrometer performs internal diagnostics to ensure reliable measurements. Any 

compromising conditions are shown in this panel, such as the instrument warming up. For 

more details, see Section 10 Troubleshooting. 

11. Spectrometer health chart 

Shows the metric that has been selected in the spectrometer health table. 

12. Spectrometer health table 

Relevant spectrometer performance metrics are shown in this table. Selecting a row plots 

the recent history of that metric in the spectrometer health chart. 

13. Status bar 

Instrument information appears in this bar, such as whether a background spectrum is 

loaded or if data is being collected. The status bar may show ‘(Calibration transfer 

disabled)’, referring to a spectral space transform technique. For most applications, 

calibration transfer between spectrometers is best done by augmenting the calibration with 

spectra from the second spectrometer. Some specialized applications benefit from using 

a spectral space transform on live data. Keit will advise on the best calibration transfer 

method during the calibration process if purchasing multiple instruments. 

14. Progress bar 

Shows the progress of the current scan. 
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3. CONTINUOUS COLLECTION: THE CONFIGURE ACQUISITION 

TAB 

When you create a new project file in Continuous Collection mode, the Configure Acquisition 

tab will appear. This allows you to change the settings for data collection. 

 

Figure 40: The Continuous Acquisition tab 

1. Scan Averaging Duration 

This sets the length of time for which spectra are averaged. Keit recommends averaging 

for 120 seconds for most applications. 

2. Project Data Viewer toggle 

When turned on, the Project Data Viewer tab will appear. This allows you to look at trends 

in the spectra over time. See Section 4 The Project Data Viewer tab for more information. 

3. Data Communication Methods 

KeitSpec can communicate data externally by four different methods: Modbus RTU 

(models ASM0627-xx-x-x-O-x-x only), Modbus TCP, OPC-UA (subject to the purchase of 

a separate OPC-UA licence), and by saving spectra to a folder over your local network. 

Use these toggles to enable the communication method(s) that are required. 

4. Background collection time 

This gives the date and time at which the background currently in use was collected. 

5. Configure Chemometrics 

KeitSpec includes analysis engines for chemometric models from various external 

software. The Configure Chemometrics button opens a window to adjust these models. 

When a model is loaded or changed, the software recalculates its outputs for all spectra 

in the Project file, which may take time for large files or complex models. See Section 3.1 

Configure Chemometrics for details. 
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6. Chemometrics output pane 

When chemometric models are loaded into KeitSpec, their outputs for the current 

spectrum will be shown in this pane. Any errors in the chemometric models will also be 

displayed here. 

3.1. Configure Chemometrics 

This allows chemometric models to be added or configured. The outputs of these chemometric 

models can be seen in the Project Data Viewer tab and are available over your DCS. No 

scaling is applied to the results as they are represented as floating point numbers. 

 

Figure 41: The Chemometrics Editor window 

1. Add new model 

This button is used to load chemometric models into KeitSpec. The following model types 

can be used: 

a. Unscrambler (Prediction): Quantitative models built using Unscrambler. 

b. Unscrambler (Classification): Qualitative models built using Unscrambler. 

Unscrambler models are supported by the integration of the Unscrambler X engine version 

11. A separate licence is required to use Unscrambler models. 

c. PLS Toolbox (Exported XML): Models built using EVRI’s PLS Toolbox 

software and exported as XML files. 

d. PLS Toolbox (Solo_Predictor): Models built using EVRI’s PLS Toolbox 

software and exported as Solo_Predictor (.mat) files. 

Solo_Predictor models are run using Solo_Predictor version 4.1, shown below. This is 

installed on your controller as a standalone piece of software and runs automatically. A 

separate licence is required to use Solo_Predictor models. 
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Figure 42: The Solo_Predictor window (standalone) 

e. Univariate: Univariate models are based on peak height tracking and can be 

useful to monitor simple reactions.  

 

 

Figure 43: Editing Univariate models 

f. Calculation: Calculation models perform calculations on the outputs of other 

chemometric models. Various mathematical operators are available, including 

Boolean logic and a time derivative (which is always performed as the final 

operation). 
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Figure 44: Examples of accepted syntax for Calculation models 

2. List of currently loaded models 

The models that are currently loaded into KeitSpec are listed here. Left-click to select a model, 

or right-click on a model to edit, duplicate or delete a model. Right-click anywhere inside this 

area to add an additional model. 

For Solo_Predictor models only, it is possible to configure the outputs of the model. To do so, 

right-click on the model and select Edit this Model. The following dialogue will appear: 
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Figure 45: Editing Solo_Predictor model outputs 

1. Metric selector. Metrics that are checked will be available for display in the 

Project Data Viewer tab and will be available over your DCS. 

2. Rename. Click here to change the name of a metric. 

3. Display Filtering Column 

To apply an exponential filter, double-click the model in the display filtering column and enter 

the desired time constant.   

 

Figure 46 - Editing Display Filtering Times 
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4. Reorder buttons 

To change the order of models, select a model and use the buttons to move it up or down the. 

5. Model output pane 

This shows a list of outputs and other information about the selected model. 

6. Done 

After configuring your models, press this to return to KeitSpec. This will apply the models to 

all spectra in the project file, which may take time for large files or complex models. 
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3.2. Chemometric Model Types 

 

Supported Model Types 

Unscrambler 
Predictor 

Unscrambler 
Classifier 

PLS Toolbox 
(Exported xml) 

PLS Toolbox 
(Solo_Predictor) 

• PLS 

• PCR 

• SVR 
 

• PLS-DA 

• SVC 

• SIMCA 
 

• PLS 

• PCR 

• SVR 

• ANN 
 

• PLS 

• PCR 

• MCR 

• LWR 

• SVR 

• ANN 

• PCA 

• PLS-DA 

• SIMCA 

• SVR-DA 

• ANN-DA 
 

 

The following model types are not supported: 

• Models which include non-wavenumber data (e.g., the dip probe temperature) 

• PLS Toolbox (Exported xml) PCA models 

• Solo_Predictor UMAP, ANNDL and ANNDLDA models 

3.3. Notes on Building and Exporting Models 

• KeitSpec can support Unscrambler models which have been exported in either Full or Short 

Prediction mode, but please note that Short Prediction mode does not support either 

Hotelling’s T2 or Q-residuals. These values will be shown as NaN in KeitSpec. 

• When using OSC, MSC or EMSC pretreatments in Unscrambler, it is important to include 

these in the model when exporting for use in KeitSpec. For PLS models ensure that the 

option to include the pretreatment models is selected; for SVR models Keit recommends 

saving a separate Unscrambler file that includes the OSC/MSC/EMSC models of interest 

and the SVR calibration and loading that into KeitSpec for use. See Section 10.2 Common 

chemometrics errors for more details. 

• Models built in PLS Toolbox must be exported correctly for them to work in KeitSpec. From 

the File menu, select Export Model > To File > MATLAB MAT file (*.mat). 
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Figure 47: Exporting a model from PLS_Toolbox 

3.4. Interpreting Confidence models 

As part of calibration, Keit may build a model to indicate whether or not we are confident in 

the results from the IRmadillo. These models will return ‘0’ if the results are within specification, 

and ‘1’ if there is low confidence in the reported values. 

There are a number of possible reasons why the IRmadillo’s results may not be reported as 

low confidence, including: 

• Your process has drifted outside its calibration space, e.g., your IRmadillo may have 

been calibrated for a range of ethanol concentrations between 0 and 15% but the 

current sample contains 18% ethanol. 

• A change has been made to your process, e.g., a different enzyme has been used that 

the IRmadillo has never ‘seen’ before. 

• The temperature or pressure of your process has moved outside the range over which 

your IRmadillo was calibrated. 

• Water vapour or another contaminant is present in the air supply to your IRmadillo 

• The spectrum from your IRmadillo has changed due to its components aging. 

In most cases, your calibration models will need to be ‘augmented’ by rebuilding with additional 

sample points. Contact Keit on support@keit.co.uk to arrange this. 

mailto:support@keit.co.uk
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4. THE PROJECT DATA VIEWER TAB 

The Project Data Viewer tab allows the display and export of the data that has been saved in 

the project file. 

 

Figure 48: The Project Data Viewer tab 

1. Trends plot options 

Use this button to display a contextual menu to allow the trends plot display to be adjusted. 

a. Time Axis: Choose whether the plot is displayed in hours since data collection 

started (Relative to Batch Start), in the timezone of the project file, or in UTC 

Standard Time.  

b. Apply display Filtering: Choose whether filtered data will be displayed or not. 

c. Export: Allows the data that are currently displayed in the trends plot to be 

exported to a range of different file types, including copying it directly to the 

Windows clipboard, to an Excel spreadsheet (requires a working copy of Microsoft 

Excel to be installed), or as an image. 

d. Autoscale Y Axes: By default, the y-axis or axes are set to show the full range of 

data. If you wish to show a smaller range, uncheck this option so that the plot does 

not rescale whenever a new sample is displayed. 

e. Export Metrics to TXT File: Allows the model outputs to be exported to a (human-

readable) .txt file. You can choose to export either only the data that are currently 

being displayed on the plot, or all the data that has been collected. 

f. Export Spectra to File: Allows the spectra themselves to be exported to a file. 

You can choose to export only the data that are currently being displayed on the 

plot (As Viewed); all the spectra that have been collected; or only the spectra which 

you have marked (by right-clicking on the Trends plot). You can then choose 

whether to export the spectra to a human-readable text file or to an SPC file. 
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g. Import Spectra: Allows the import of spectra from different project files to the 

current project file 

h. Time options: The time period over which data are displayed may be adjusted as 

required. 

 

2. Trends plot 

Shows chemometric model outputs over time. If no models are present, the plot will be 

blank. Measurements can be displayed on the primary or secondary y-axis. Moving the 

cursor over the plot shows the spectrum measured at that time in the Spectra pane. 

To mark individual spectra for correlation with external events (e.g., adding reactants or 

adjusting parameters), hover over the desired spectrum/time period, right-click, select 'Set 

Marker Here,' enter a name, and click OK. 

 

3. Trends plot legend 

This gives a key to the items that are plotted in the Trends plot. You can right-click on the 

text of an entry to change whether it is plotted against the left or right y-axis.  

4. Trends plot range options 

This control allows the time scale shown on the Trends plot to be changed. 

Off holds the current view range unchanged as data are updated. 

Autoscale (default) shows all the data that have been collected. 

Leading shows the most recent data; the history is defined by the range chosen in the 

options for the trends plot. 

5. Spectra plot options 

Use this button to display a contextual menu to allow the spectra plot to be adjusted. 

a. Add Plot: Add the spectrum of a marked sample to the plot. 

b. Display Type: Allows you to choose whether to display absorbance spectra, 

transmission spectra or raw spectra. 

c. Autoscale X/Y: The X and Y ranges of the plot are scaled to show the whole 

spectrum. If you wish to concentrate on a smaller range, unchecking these options 

will prevent the plot rescaling each time a new sample is displayed. 

d. Export: Allows the data that are currently displayed in the spectra plot to be 

exported to a range of different file types, including copying it directly to the 

Windows clipboard, to an Excel spreadsheet (requires a working copy of Microsoft 

Excel to be installed), or as an image. 

6. Spectra plot 

This plot shows the most recent spectrum (‘Newest’), the spectrum under the cursor in the 

Trends plot (‘At Mouse’), and any marked spectra that have been selected. 

7. Export 

Allows spectra or trends to be exported. 

a. Export Metrics to TXT File: Allows the model outputs to be exported to a (human-

readable) .txt file. You can choose to export either only the data that are currently 

being displayed on the plot, or all the data that has been collected. 
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b. Export Spectra to File: Allows spectra export to a file. Choose to export data 

currently displayed (As Viewed), all collected spectra, or only marked spectra 

(right-click on Trends plot). Options include a human-readable text, or SPC files. 

8. More 

For each spectrum, diagnostic information is available to assess the instrument or 

calculation performance. The spectrum for which information is displayed is the one under 

the cursor if the cursor is over the Trends panel, or for the most recent spectrum if not. 

a. Show Frame Info: Opens a floating window that displays diagnostic information 

about the spectrometer for that spectrum.  

b. Show Frame Info (Full): Opens a floating window that displays extensive 

diagnostic information about the spectrometer for that spectrum.  

c. Show Chemometrics Info: Displays the model output from the current set of 

calculation parameters for that spectrum. 

d. Show Spectrometer Settings: Displays a floating window with information about 

the spectrometer, including software version numbers and serial numbers. 

e. Backgrounds (Change or Export): Allows the saved spectra to be re-calculated 

using a new background (reference) scan and allows the export of the current 

background scan. 
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4.1. Changing and Exporting the Background Scan 

This allows the background spectrum that was used to calculate the absorbance spectrum to 

be changed. This is useful if, for example, you discover that your probe was not clean when 

you calculated the original background spectrum, which would mean that all data collected 

subsequently would be incorrect. 

 

Figure 49: The Change Backgrounds window 

1. Select Backgrounds 

Choose the spectra for which you would like to change the background. The spectra are 

grouped by the background that is currently applied. Backgrounds that have been 

collected but with which no spectra have been taken will not appear in this list. 

2. Export Selected 

Allows the currently selected background spectra to be exported as a text file. 

3. Background Display 

This shows the currently selected and, if chosen, new background scans, in order to allow 

verification that the replacement background makes sense. Check to ensure that you are 

happy with the replacement background before proceeding with the substitution. 

4. Select New Background Source 

Select the source of the background that you wish to use to replace the current 

background. This can be a different background scan from the current project; a 

background scan saved in a different project file; or a spectrum that has been saved as a 

KeitData file. 
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5. Change Selected Backgrounds 

Recalculates the absorbance spectra with the new background. This operation is 

irreversible, so please ensure that you have saved a copy of the project file before 

proceeding. 



 Page 45 

 

DOC0893 KeitSpec Software User Manual (28 March 2025 11:17) 

www.keit.co.uk Back to Table of Contents  

5. DATA COMMUNICATION – MODBUS RTU SLAVE 

The IRmadillo (model numbers ASM0627-xx-x-x-O-x-x only) supports data communication 

using Modbus RTU.  

5.1. Enabling the Modbus RTU Slave tab 

To enable communication by Modbus RTU, one must first create or open a continuous project 

(see Section 1.3 Collecting spectra in a continuous process). Then, under Data 

Communication Methods, move the relevant Data Communication Methods switch to ON (1). 

This will reveal the Modbus RTU Slave tab (2). 

 

Figure 50: Enabling Modbus RTU Slave 

For more information on implementing and configuring Modbus RTU, see DOC0871 

Commissioning Guide: Data Communication – Modbus RTU. 
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5.2. Modbus RTU Slave tab 

 

Figure 51: The Modbus RTU Slave tab 

1. Enable Slave 

Switch Enable Slave to ON to begin communicating with your DCS/Modbus server. 

2. Modbus settings 

Configure the slave settings as required to match your DCS settings. This can only be 

done while Enable Slave is switched to OFF. 

3. Register List 

The available data outputs, their data types, and register addresses are shown in the table. 

Select a register to view its contents in the Register View box below. The register numbers 

are given in decimal. 

4. Hold Display 

If the Command Debug view is changing too rapidly to read, use this button to freeze the 

display. 

5. Command Debug 

The last Modbus command that was received, along with the response that the instrument 

returned are shown in this box (as Modbus RTU strings). Various other metrics are shown 

to assist with debugging a connection to your DCS. Note that the frame number will update 

every averaging time. 

6. Description of Last Command-Response 

KeitSpec’s response to the last command is shown here. The response will be interpreted 

in various ways to show you what you should expect from your Modbus RTU server. 

7. Register View 

Displays the contents of the register that is selected in the list above. Check the Show in 

Hex box to view the data in hexadecimal format. 
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6. DATA COMMUNICATION – MODBUS TCP SERVER 

The IRmadillo supports data communication using Modbus TCP.  

6.1. Enabling the Modbus TCP Server tab 

To enable communication by Modbus TCP, one must first create or open a continuous project 

(see Section 1.3 Collecting spectra in a continuous process). Then, under Data 

Communication Methods, move the relevant Data Communication Methods switch to ON (1). 

This will reveal the Modbus TCP Server tab (2). 

 

Figure 52: Enabling the Modbus TCP Server tab 

For more information on implementing and configuring Modbus TCP, see DOC0817 

Commissioning Guide – Data communications – Modbus TCP.  

6.2. Modbus TCP Server tab 

The Modbus TCP Server tab is shown below: 

 

Figure 53: The Modbus TCP Server tab 
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1. Port number selection 

Configure the server’s port number as required to match your DCS settings. This can only 

be done while Enable Server is switched to OFF. 

2. Enable Server 

Once the port number is selected, switch Enable Server to ON to begin communicating 

with your DCS/Modbus client. 

Windows Defender Firewall may prompt you to enter your administrator password on 

switching Enable Server on for the first time. 

3. Network Adapters and Client Connections 

Information on current network connections and their status (Network Adapters), and 

active Modbus TCP connections (Client Connections).  

4. Command Debug 

The last Modbus command that was received, along with the response that the instrument 

returned are shown in this box. Use the Hold Display button to freeze the display if the 

values change too rapidly to read. The number of messages processed and errors 

received are also shown to assist in debugging a connection to your DCS. 

5. Register List 

The available data outputs, their data types, and register addresses are shown in the table. 

Select a register to view its contents in the register box (6) below. In this example, 1016 

“Frame Number” is selected. The contents of the chemometric results registers (registers 

8000–20000) will depend on which chemometric analysis is being performed. The register 

numbers are given in decimal. 

6. Register View 

Displays the contents of the register that is selected in the list above. Check the Show in 

Hex box to view the data in hexadecimal format. 
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7. DATA COMMUNICATION – OPC-UA 

The instrument can communicate over OPC-UA with a plant control system, subject to the 

purchase of an additional software license for the OPC server. This tab allows the 

communication to be set up and communications to be debugged.  

OPC-UA requires an active connection to a local network that is shared with the computers or 

control hardware that will consume the data that the IRmadillo generates. 

7.1. Enabling the OPC-UA tab 

To enable communication by OPC-UA, one must first create or open a continuous project (see 

Section 1.3 Collecting spectra in a continuous process). Then, under Data Communication 

Methods, move the relevant Data Communication Methods switch to ON (1). This will reveal 

the OPC-UA tab (2). 

 

 

Figure 54: Enabling the OPC-UA tab 
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7.2. The OPC-UA tab 

For more information on implementing and configuring OPC-UA, see DOC0828 

Commissioning Guide – Data communications – OPC-UA. 

 

Figure 55: The OPC-UA tab 

1. Communications and security settings 

Configure the OPC-UA server to match your plant control system’s settings. 

2. Enable server 

Once the settings are configured, use this switch to begin communicating with your OPC-

UA client. 

3. Frame number 

This displays the frame number in KeitSpec. This can be useful for debugging. It will 

update every scan averaging duration. 

4. Command Debug 

The last OPC command that was received is displayed in this box to help with debugging 

the connection to the plant control system. 

5. Network Adapters  

This gives a list of the available adapters and current connections to the controller. 
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8. DATA COMMUNICATION – AUTOSAVE TO FOLDER 

The Autosave to Folder function allows you to save absorbance spectra to a folder 

automatically as they arrive, so that they can be read in real-time by another program (a 

‘watched folder’). 

8.1. Enabling the Autosave to Folder tab 

To enable communication by autosaving to a watched folder, one must first create or open a 

continuous project (see Section 1.3 Collecting spectra in a continuous process. Then, under 

Data Communication Methods, move the relevant Data Communication Methods switch to ON 

(1). This will reveal the Autosave to Folder tab (2). 

 

Figure 56: Enabling the Autosave to Folder tab 

For more information on implementing and configuring autosaving to a watched folder, see 

DOC0876 Commissioning Guide – Data Communication – Watched Folder. 
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8.2. The Autosave to Folder tab 

 

Figure 57: The Autosave to Folder tab 

1. Folder to Save To 

The folder in which spectra will be saved. This may be local or over a network. 

2. Enable Saving 

Turn data saving on and off using this toggle. 

3. Format 

Spectra can be saved either in text (.txt) or SPC format. 

4. Last Save 

The filename and full path of the most recent spectrum to be saved. Note that the filename 

is the time at which the spectrum was collected. 
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9. MANUAL SAMPLING: THE SAMPLE ACQUISITION TAB 

Creating a new Manual Sample Acquisition project or opening a previously stored one will 

cause the Sample Acquisition tab to appear in the tab bar. This project type will allow you to 

collect individual spectra. 

 

Figure 58: The Manual Sample Acquisition tab 

1. Sample Name 

Each sample that you collect can be named for later identification 

 

2. Time to scan 

Use this box to specify the sampling duration for each spectrum. Keit recommends 
sampling for 120 seconds.  

 

3. Samples 

If you wish to make several measurements of a single sample, specify the number in the 
Samples box. The instrument will make successive scans of the same sample. Keit 
recommends taking three measurements of each sample. 

 

4. Collect Sample 

Click this button, or press F1, to begin sampling. 

As each measurement is collected, the number in the Samples box will automatically 
decrease to show the number that remain to be collected. Collection is also indicated by 
the button turning green and both the status bar and progress bar displaying the action. 
Samples are automatically saved to the current project – there is no separate ‘Save’ action. 
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5. Data panel 

After each sample has been collected, information about it will appear in this panel. Each 
line refers to a different measurement. To display the absorption spectrum for that sample 
in the spectrum panel (9), click on it. Multiple spectra may be selected by Ctrl-clicking with 
the mouse. Right clicking a sample provides additional options. 

a. Edit this sample: Allows you to rename a sample. 

b. Delete this sample: Permanently erases a sample. A warning dialogue will 
appear. 

c. Show Sample Frame Info: Opens a floating window that displays diagnostic 
information about the spectrometer for that sample. 

d. Show Sample Frame Info (Full): Opens a floating window that displays extensive 
diagnostic information about the spectrometer for that spectrum 

e. Backgrounds (Change or Export): Allows the saved spectra to be re-calculated 
using a new background (reference) scan, and allows the export of the current 
background scan. See Section 4.1 Changing and Exporting the Background Scan 
for more information on how to use this feature. 

 
6. Configure chemometrics 

The KeitSpec application contains analysis engines that can use chemometric models 
generated by a number of software vendors. When a model is configured, a summary of 
the results output is visible in the data panel (5).  
 
This button opens a floating window to allow the chemometric model(s) to be configured 
and adjusted. When the model is loaded or changed, the software will reprocess all 
samples in this project against it. This may take a few minutes for a large batch or complex 
model. Refer to Section 3.1 on Chemometrics for further information about the 
chemometric models. 

 

7. Export 

Use this button to export data about the samples for use with analytical software (such as 

chemometric model-building software). You can export the sample metrics which contains 

all the data displayed in the data panel (5) or export the spectra which contains the raw 

data. 

a. Export metrics to TXT file 

i. Selected samples 

ii. All data 

b. Export spectra to file 

i. Selected samples 

ii. All data 

 

8. More (see Section 4 The Project Data Viewer tab) 

a. Show Sample Frame Info  

b. Show Sample Frame Info (Full)  

c. Backgrounds (Change or Export)  
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9. Spectrum panel  

The spectrum of the currently selected sample(s) in the data panel (5) is displayed in this 

panel. Several spectra may be overlaid by selecting multiple samples in the data panel by 

Ctrl-clicking on multiple rows. 

 

10. Graph panel options 

Provides additional options for the Spectrum panel (9). These can also be accessed by 

right clicking the Spectrum panel. 

a. Display Type 

You can change what is displayed on the spectral panel depending on what 

provides the most value to you. 

i. Absorbance 

ii. Transmission  

iii. Raw Spectrum 

b. Visible items 

i. Plot Legend 

c. AutoScale X 

The X range is scaled to show the whole spectrum. Uncheck this option to see sections 

of the range without rescaling 

d. AutoScale Y 

The Y range is scaled to show the whole spectrum. Uncheck this option to see sections 

of the range without rescaling 

e. Export  

Allows the data that is currently displayed in the spectrum panel (H) to be exported to 

a range of different file types, including copying it directly to the Windows clipboard, an 

Excel spreadsheet (requires a working copy of Microsoft Excel to be installed), or as 

an image. 

i. Export Data to clipboard 

ii. Export Data to Excel  

iii. Export Data to DIAdem 

iv. Export simplified image 
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10. TROUBLESHOOTING 

If you encounter any issues during integration and use of the IRmadillo, please contact Keit 

(support@keit.co.uk). 

10.1. Controller administrator guidance 

When connecting the IRmadillo’s controller to communicate to your distributed control system 

(DCS) using Ethernet, you will need to connect it to your local area network (LAN). Some 

changes may be required to ensure compliance with your internal Information Technology (IT) 

policies. Changes to the controller may cause the spectrometer to become unreliable. The 

information below should help to avoid problems. 

Item Guidance 

User account to run 

spectrometer 

A domain or local user account may be used. KeitSpec does 

not support simultaneous running by two different users. 

Keit recommends always using the same user account to 

run the spectrometer. 

Automatic Login 

The controller incorporates an auto-restart feature. To take 

advantage of this, the user account allocated to run the 

spectrometer must be set to automatically log in and run the 

KeitSpec software. 

Domain Joining 

You may join the IRmadillo to your domain network.  When 

you do this be careful not to accidentally disable the auto-

restart functionality.  Examples of possible problems include: 

- Legal notices requiring user intervention on login 

- Automatic login being disabled 

If auto-restart is disabled then you will need to manually 

access the IRmadillo and login to the user account. 

Administrator account 

Do not use the administrator account for running the 

spectrometer. The administrator account should only be 

used to configure the controller. 

A domain or local user account may be used for normal 

operations. 

Virus scanning software 

You may install your own anti-virus software, but Keit does 

not guarantee reliability if you do so. 

When installing an anti-virus solution, please ensure it does 

not disrupt the spectrometer by consuming too much CPU 

when scanning or updating. 

Windows updates 

Windows updates may cause spectrometer outages, 

including automatic restarting of the controller. Windows 

updates are set to be run manually by default so that they 

can be installed during planned maintenance. 

BIOS password You may set a BIOS password if you wish. 

mailto:support@keit.co.uk
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Firewall 

For Modbus TCP and OPC-UA communications, the 

KeitSpec application will need to be granted permission to 

communicate over your network. 

If you experience problems connecting, then check the 

controller’s firewall policy. 
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10.2. Common chemometrics errors 

Issue 
Possible 

Cause 
Potential Solution 

Error 5115 occurred at 

Unscrambler: 

ERR_SUBMODEL_ERROR: 

Error in a sub-model file 

such 

as MSC/EMSC/OSC. 

Multiple models 

have been 

applied in 

Unscrambler, 

but not all the 

models have 

been loaded 

into KeitSpec. 

Import the whole Unscrambler file into 

KeitSpec, then select the correct model 

from within KeitSpec. 

Error 5151 occurred at 

Unscrambler: 

ERR_INPUT_ERR: Some 

error in data used for 

prediction, e.g., column 

dimension mismatch. 

Classifier 

models: The 

spectra on 

which the 

model was built 

has a different 

wavenumber 

range to that 

used by the 

spectrometer. 

Rebuild the model using the full 

wavenumber range. 

Error 5000 occurred at 

PLS Toolbox 

(Solo_Predictor). Error 

using parsemixed. No 

numerical data could be 

found in the file. 

The model has 

not been 

correctly 

exported from 

PLS Toolbox. 

Export the model correctly (see Section 

3.3 Notes on Building and Exporting 

Models). 

The model is 

not 

communicating 

with 

Solo_Predictor. 

Ensure that Solo_Predictor is running; 

delete the model from within KeitSpec; 

close and restart KeitSpec; then re-

import the model. 

Models return 0, NaN or no 

results 

One or more 

unsupported 

models or 

pretreatments 

have been 

used. 

Choose a different model or 

pretreatment. Refer to Section 3.2 

Chemometric Model Types. 

An 

Unscrambler 

Classifier 

model has 

been imported 

as an 

Unscrambler 

Predictor model 

or vice versa. 

Ensure that the correct model type has 

been imported. 
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Issue 
Possible 

Cause 
Potential Solution 

Predictions that do not 

match those in 

Unscrambler, 

PLS_Toolbox or Solo 

Wavenumber 

axis has been 

inverted. 

Rebuild the models with the correct 

wavenumber axis. 

One or more 

unsupported 

models or 

pretreatments 

have been 

used. 

Choose a different model or 

pretreatment. Refer to Section 3.2 

Chemometric Model Types. 
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11. OFFLINE VIEWER 

The KeitSpec Offline Viewer allows previously collected spectra to be explored and visualised. 

Opening KeitSpec Offline Viewer will automatically prompt you to select a file to load. Select 

a .KeitSpec file and click OK to load it, or else click Cancel to proceed without loading data to 

view. 

 

Figure 59: The Offline Viewer 

1. Chemometrics 

The Configure Chemometrics button opens a new floating window which allows the 

chemometric model(s) to be configured and adjusted. Please note that when a model is 

loaded or changed, the software will automatically recalculate the outputs of this model for 

all spectra stored in the Project file. For large Project files or complex models, this may 

take a long time. 

Refer to Section 3.1 Configure Chemometrics for more information about chemometric 

models. 

2. Open Project 

Opens a file explorer dialogue to allow a project file to be opened. 

3. More options 

a. Change Timezone: Allows the user to change the timezone in which the project 

file is saved. 

The appearance of the offline viewer will vary depending on whether the project that has been 

opened is a continuous or manual project. 
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11.1. Offline viewer: Continuous data collection 

 

Figure 60: The Offline Viewer: Continuous Collection mode 

When a Continuous Collection project is open, the settings and options in the offline viewer 

are identical to of the Project Data Viewer tab in KeitSpec. Please refer to Section 4 The 

Project Data Viewer tab for more information. 
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11.2. Offline viewer: Manually collected samples 

 

Figure 61: The Offline Viewer: Manual Sample Acquisition mode 

When a Manual Sample Acquisition project is open, the settings and options in the offline 

viewer are identical to those of the Sample Acquisition tab in KeitSpec. Please refer to Section 

9 Manual Sampling: The Sample Acquisition tab for more information. 
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12. LOG VIEWER 

The KeitSpec application automatically logs various events, changes that are made to its 

configuration, and performance information about the spectrometer. Logs are also useful in 

case you need to contact Keit for service assistance. A log file is created for each month that 

the instrument is operating. 

The log viewer software is installed on your computer when you install the main KeitSpec 

application. When you start the Log Viewer, it will prompt for you to choose the log file that 

you wish to view. These log files are stored by default in Users\Spectrometer 

User\Documents\LabVIEW Data\KeitSpec\Log. 

 

Figure 62: The KeitSpec Log Viewer 

1. Menu bar 

a. File: Allows you to open a different log file, output the current log file to a variety 

of data formats, or close the KeitSpec log viewer. 

b. Window: Allows the display of a secondary window to show the full text of a log 

entry; to open a second log file for direct comparison with the first; or to expand 

the log viewer window to full screen. 

c. DisplayOptions: Allows you to display the full timestamp and source information 

rather than the sparse displays as shown in the above screengrab. 

d. Help: Allows the display of a contextual help window. 
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2. Sources dropdown 

Filters the events displayed on the log file, so only events from, e.g., the spectrometer itself 

are displayed. 

3. Search bar 

Allows you to search through the events using a keyword. This search uses SQL syntax. 

Use % as a wildcard. 

4. Log Levels 

There are a series of different log levels that are recorded. Use this dropdown to choose 

the most appropriate level of detail. 

Log Level Serious Standard Verbose Debug 

Instrument errors x x x x 

Application events (e.g., 
start/stop) 

 x x x 

Settings changes   x x 

Settings configuration errors; non-
fatal errors and warnings 

   x 

 

5. Log entries 

Each log entry is displayed in a new row in the table. Hover the mouse pointer over the 

field to display any information that overflows the space that is available. 


